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INTRODUCTION
About This Program

This part of the Legal Series with Catherine Crier provides information to help managers
and supervisors understand the requirements of the Fair Labor Standards Act (FLSA).The
coverage of the FLSA is broad and most employers are not in full compliance. Failure to
comply with these federal regulations can result in very significant penalties for any
organization. It is important that management personnel have awareness of the FLSA
requirements and apply them consistently.

This Leader’s Guide is designed to help you conduct a thorough training session on the
FLSA. It permits you to use this program in many different ways, giving you the flexibility
to determine which training format is best for your organization’s needs. The program
is approximately 22 minutes long and can be stopped easily for discussion of

important points.

A PowerPoint® presentation is provided to assist you in the presentation of this material.
As an alternative, the slide information may be printed or transferred to transparency
sheets or a flipchart when used in conjunction with the program. lllustrated desk
references are also available for use with this program.These desk references may be
given to participants as a helpful note-taking and reference tool.

We recommend that you tailor the program to your organization’s needs by including
specific information unique to your employees. The specifics of how you facilitate this
course are determined by you.
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Training Materials
There are a few things you'll need for an effective training session:

0 A training room located away from major distractions or interruptions

[0 A comfortable arrangement of chairs with an opening for a TV monitor or projection
screen and other visual aids (Be certain all participants can see the screen and each
other.)

[J Adequate lighting that can be adjusted while viewing the program

0 A location, possibly including a podium from which the trainer/speaker can
lead discussion, and a flipchart

(I The training program HR Case Files with Catherine Crier:The FLSA.

O TV andVCR or DVD player/computer with projector

[ Copies of the class agenda (page 4)

[J A desk reference, paper and pencil for each participant

O A flipchart or dry-erase board and appropriate markers

O A computer with PowerPoint® software and the PowerPoint® Presentation
O Copies of the Post-Test and Evaluation (pages 14 and 15).

Preparation
Preparation is the key to efiective training. Do these things prior to the session:

Establish Objectives
Suggested training objectives for this presentation are:

» Understand the purpose of the FLSA

* Know the minimum wage requirements

* Recognize the importance of accurate compensation

» Understand the exempt and non-exempt classifications
* Be aware of the penalties for non-compliance

» Know how to avoid common compliance pitfalls.

Feel free to edit the training objectives to meet the particular needs of your organization.
Training objectives should reflect the content of the program.

Determine the training objectives in advance so that you can identify the approach to
take for the training session. It is also important to decide what level of understanding is
expected from participants upon completion of the training.
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Determine the Audience

Another aspect to consider in planning this training session is the audience. Tailor your
presentation to the skills or experience of the participants. The focus of your discussion
and the depth of content presented may vary, depending on whether you are providing an
orientation for new employees or a refresher course for all employees.

The training group size should range from 10 to 20 people. Most of the exercises in this
program require that the group break into two smaller groups in order to increase
participation.When the group is too large, individual attention may be lost.

Invite Participants

Send out letters, memos or e-mails to participants or post a notice two weeks in advance
of the training date. (Sample included on page 5.) State the location, date and time, and
meeting agenda. Administer the Pre-Test in advance.

Agenda

1.5-Hour Session Agenda

Introduction 15 minutes
Program & Discussion 60 minutes
Session Summary 15 minutes

2-Hour Session Agenda

Introduction 5 minutes
Program & Discussion 40 minutes
Exercise 1 25 minutes
Exercise 2 30 minutes
Break 10 minutes
Session Summary 10 minutes
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Sample Invitation

Date: June 10,20

To: All Managers

From: Janice Bax, Human Resources Manager
Re: HR Case Files with Catherine Crier: The FLSA

You are invited to attend an important training session on the requirements of the Fair
Labor Standards Act. This broad reaching federal regulation covers the minimum wage,
overtime pay, equal pay, record keeping and child labor standards. HR Case Files with
Catherine Crier: The FLSA will help you to understand and comply with the FLSA.

Please plan to be at the training session on June 20 at 2:00 p.m.\We will be meeting in the
main conference room for a 2-hour session. If you are unable to attend, please contact me at
555-8890 as soon as possible.

A few goals of the training session are:

» Understand the purpose of the FLSA

* Know the minimum wage requirements

* Recognize the importance of accurate compensation

» Understand the exempt and non-exempt classifications
* Be aware of the penalties for non-compliance

» Know how to avoid common compliance pitfalls.

Agenda:

Introduction 5 minutes
Program & Discussion 40 minutes
Exercise 1 25 minutes
Exercise 2 30 minutes
Break 10 minutes
Session Summary 10 minutes

We look forward to seeing you on Thursday, June 20.
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Presentation Tips

Overcoming anxiety

The best way to overcome anxiety about speaking before a group is to be prepared.
Although it is natural to be nervous, your sweaty palms will disappear once you focus on
what you are saying. Concentrate on communicating your message and your presentation
will flow naturally.

Choosing your vocabulary
It's best to use the same comfortable language that you would use when speaking one-on-
one. Avoid jargon and overly complicated words or phrases.

Getting rid of the “umms”

One of the most annoying mistakes a speaker makes is saying “umm?” every time there is a
break between thoughts. Remain silent while you think about what you're going to say
next. The silence will seem longer to you than it will to the audience. If you remember
this, you'll feel less pressure to fill the silence.You can control your “umms” by jotting
down notes beforehand. If you want to include personal anecdotes or examples, write
down a few notes to trigger your memory. Beware of writing down too much, however.
You'll deliver your message to your note cards instead of your audience.

Controlling the speed and tone of your voice

You'll put your audience to sleep if you speak too slowly, and they won’t be able to keep
up with the content if you speak too quickly. Approximately 150 words per minute is the
best speed (that’s about two thirds of a page, typed, double-spaced).Vary your tone often,
especially when making an important point. Adding emotion to your presentation will
keep your audience involved. Again, strive for a conversational tone.

Sticking to the schedule
Begin class on time and restart the session promptly at the end of the break. Except for
emergencies, participants should not be interrupted for messages.

Asking for questions

Ask for questions throughout the session. Be prepared to answer all types of questions,
but don’t be worried if you don’t know every answer.You can simply say, “Let me find
out for you and get back to you.” Keep in mind many questions are best answered
through discussion. An appropriate response might be, “Good question. Let’s hear some
discussion on that one.” Watch the clock, though.Too many unplanned discussions can
eat up your time.
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TRAINING SESSION OVERVIEW

Giving the Pre-Test

It is recommended that you give the Pre-Test prior to the training session.That way, you
will have an opportunity before the session begins to review participant’s answers and get
an idea of what they already know. Otherwise, administer the Pre-Test at the start of the
session so you can review participant’s responses during the break.

Presentation Outline
Open the session. Welcome the participants and introduce yourself to the group. Give
a brief explanation of the purpose of the session and quickly review the agenda.

Have participants introduce themselves and state the department or area in which
they work.You may want to use an “icebreaker” to get the class warmed up for group
discussion and to get to know each other.

Distribute and review copies of the training objectives for this session. Be sure
participants understand what you expect them to learn and what skills they need to
display as a result of this training. Knowing what is expected in advance better prepares
the employees and helps them to participate successfully.

Obijectives for this training session are:

(0 Understand the purpose of the FLSA

00 Know the minimum wage requirements

[0 Recognize the importance of accurate compensation
0 Understand the exempt and non-exempt classifications
[0 Be aware of the penalties for non-compliance

0 Know how to avoid common compliance pitfalls.

Discussion Guides

Two discussion guides have been developed for this program.“Scene-Specific Discussion
Guide” is designed to be used if you choose to view the program in chapters (DVD) and
discuss each scene.*“Discussion Topics Guide” is designed to be used after watching the
program in its entirety. After determining the best approach for your training group, start
the program. It’s a good idea to adjust the volume of the monitor before the training
session begins. Doing so avoids startling participants if the sound is too loud or frustrating
the participants with missed information because the sound is too low.
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Training Points have been created on the DVD format of this program to provide visual
aids when sharing important training material, or reviewing content of the program.Video
links are included to provide visual reinforcement of some of the Training Points.

Resource Materials are available when playing the DVD in a DVD-ROM drive. A
PowerPoint® presentation, identical to the Training Points content of this program, has been
included in both formats for your use.The customizeable version is available for you to add
specific information for your company. Tips for customizing this presentation are included
on page 19.

Scene Specific Discussion Guide

The five scenes in this program provide an opportunity to discuss the provisions of the
Fair Labor Standards Act. This guide is broken down with a summary of each scene,
offering discussion questions for each segment of the program.

Introduction
In this opening segment, news anchor Catherine Crier and reporter Doug Aronson
highlight the complexities of the FLSA. Ask participants:

» What standards did the Fair Labor Standards Act create?
*Who does the FLSA apply to?
* How do you interpret “regularly exercising independent judgment and discretion”?

Basics

Reporter Glenn Corillo reviews compensation of non-exempt and exempt employees in
this segment. Timothy Richardson addresses some of the penalties of non-compliance.
Catherine Crier and Perry Ludy discuss recordkeeping guidelines. This would be a good
opportunity to share how your organization handles recordkeeping issues. Ask
participants:

* Do you have non-exempt employees who eat lunch at their desk? How should you
handle their lunch period?

* Do any of your non-exempt employees volunteer to come in early or stay late, or
take work home? How should you handle this type of situation?

* How would our organization sustain damages as described in this program?
Exemptions

During this segment, reporter Glenn Corillo shares some important distinctions to
consider when classifying employees. Ask participants:

» What situations in your area cause you to question whether your employees are
being paid appropriately?

* Are there any “exempt” employees under your supervision you think might really be
“non-exempt”? Why?

HR Case Files with Catherine Crier: The FLSA 4 8 )
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Compliance
Catherine Crier and Perry Ludy return during this segment to answer questions regarding
compliance with the FLSA. Ask participants:

» Which of these questions could you identify with? Why? Does Perry Ludy’s response
answer your concern?

Summary

During this segment, reporter Doug Aronson and attorney Bob Thompson share stories
illustrating the dangers of non-compliance. Using slide 9 as a summary tool, review the
many things supervisors and managers can do to remain in compliance with the FLSA.

Discussion Topics Guide

Follow the program with a discussion. Discuss the following highlights using the
PowerPoint® presentation to support your discussion. The desk reference is also a
valuable tool for participants to use during the discussion, and to take back to their
workplaces as a handy reference following the program. Appropriate pages are
referenced throughout this discussion guide.

1. Program QObjectives
Use slide 2 as a guideline to review the overall training objectives for this session.

2.What is the FLSA?
Using slide 3, explain the purpose of the Fair Labor Standards Act. Refer participants to
page 2 of the desk reference.

3. Minimum Wage

Using slide 4, explain the rules of appropriate compensation. If your state sets a higher
minimum wage, be sure to communicate this distinction! Refer participants to page 3 of
the desk reference.

4. Overtime Compensation

Using slide 5, explain how overtime hours should be compensated. If your organization
compensates overtime at a higher rate, be sure to share this information. Refer
participants to page 4 of the desk reference.

5. Exemptions

Using slide 6, review how a position becomes classified as exempt. It is helpful to use
actual positions in your organization as examples. Refer participants to page 8 and 9 of
the desk reference.

6. Compensate All Hours Worked
Using slide 7, share the many ways a supervisor should remain vigilant when it comes to
how employees record hours worked.

HR Case Files with Catherine Crier: The FLSA 4 9 )
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7. Penalties

Using slide 8, share the many ways the Department of Labor has levied penalties for
noncompliance with the FLSA. Sharing recent court cases can be helpful. Refer
participants to page 10 and 11 of the desk reference.

8. Avoiding Compliance Pitfalls

Using slide 9, summarize the program by reviewing the many things each supervisor and
manager within an organization may do to avoid noncompliance with the FLSA. Refer
participants to page 13 of the desk reference.

HR Case Files with Catherine Crier: The FLSA 4 10 »
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EXERCISES

The following exercises are provided for use after the discussion. Refer to the agenda to
determine which exercises you have scheduled in your training session. Make sure you
stick to the time schedule for each exercise to avoid running out of time at the end of the
training session.

Exercise #1
Avoiding Future Problems

Time: 25 minutes
Materials: Paper and pen for each participant.

For the first 10 minutes have each person think about the following questions:
*Where are we vulnerable to FLSA violations?

*\What can we do to correct the situation?

Record the potential problem areas on an overhead transparency or flipchart. After all
the problems have been identified, solicit input on the changes needed to correct them.

Exercise #2
How Should We Compensate?

Time: 30 minutes
Instructions: Work through each of the following scenarios with participants, discussing
how the FLSA would guide compensation.

Overtime Compensation
Tamisha turned in the following timesheet for last week (post on a white board or
flipchart)

Monday 8 hours
Tuesday 10 hours
Wednesday 8 hours
Thursday 8 hours
Friday 6 hours
Saturday 0 hours
Sunday 0 hours

Ask participants:
» Should Tamisha be paid overtime for additional hours worked on Tuesday?

No. Because Tamisha’s total hours worked for the week did not exceed 40 hours, no
overtime compensation is necessary. (This answer can be customized if there are state
overtime laws applicable to daily hours.)

HR Case Files with Catherine Crier: The FLSA 4 11 D
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Compensatory Time Off
Jason wants to take Monday off, and work the Saturday prior to make up the time.The
company work week runs Monday through Sunday. Ask participants:

e Can he?

Not without violating the FLSA. Jason should be paid the exact hours worked each week.
The week prior to the planned absence would include the additional hours worked on
Saturday. The week of the absence would reflect fewer hours than usual. And yes, the
week prior Jason would be eligible for overtime compensation if his hours were over 40
for the week.

Time off with Pay or a Day Worked?

Jocelyn is employed as an exempt outside sales representative. She comes to work on
Friday for 2 hours and then goes home for the day. Jocelyn does not have any paid time
off benefits remaining. Ask participants:

* Does she get paid for a full day’s work, or just for the 2 hours worked?

Jocelyn would be paid for a full day’s work, even though she went home for the remainder
of the day. The FLSA regulations state that an exempt employee’s hours will not be
reduced from a full day’s compensation.
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BONUS MATERIAL

An additional scene has been included with the DVD format of this program.This scene
may be used to further discuss specific topics. The following guide may be used for
discussion:

The Interview

This segment shows a legal and effective interviewing process, from beginning to end. It
may be used as a summary to the training program, or as an opportunity for further
discussion. Ask participants:

*What kinds of questions could arise after reviewing an applicant’s resume?
» How can you elicit examples of previous behavior on the job?
»What types of information would an applicant want before leaving his or her first interview?

It's AWTrap

This 3-minute segment included on the DVD format of this program may serve as an
introduction to the training program, or as a closing video clip. During this segment, two
commentators dialogue and summarize the content of the program by reviewing the key
points of the standards and guidelines created by the FLSA.

SESSION SUMMARY

Summarize

One summarizing technique is to review the course objectives with the class. Another
technique is to ask each participant to highlight what was learned from the training
session. Ask the participants if they have any final questions.

Administer Post-Test

Distribute copies of the Post-Test (located on page 14) to each participant.You may
wish to customize the Post-Test to fit your organizational objectives. The Post-Test is an
excellent tool for determining how much each participant learned during the session.
Compare the results to the Pre-Test and review the different answers.

Evaluate

Distribute the evaluation form (located on page 15) to participants when they have
finished answering the questions on the Post-Test.When each participant returns the
evaluation form to you, thank him or her for attending the session.

HR Case Files with Catherine Crier: The FLSA 4 13 p
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PRE-TEST/POST-TEST

Please read each statement carefully and indicate whether it is true or false, and why.

1. True False The FLSA covers minimum wage, overtime pay, equal pay, record
keeping and child labor standards.

2. True False All salaried employees are exempt from overtime payments.

3. True False Job titles are a key determining factor in exempt classifications.

4. True False Employers must pay for all hours worked even when employees
volunteer to work “off the clock.”

5. True False If an employee is working and eating during his lunch break it is not
considered to be compensable time.

6. True False Federal minimum wage takes precedence over state minimum wage.

7. True False The FLSA requires overtime payments if an employee works over
40 hours in a week or 8 hours in a day.

8. True False One intent of the FLSA is to ensure that employees are fairly
compensated.

9. True False Non-exempt employees usually receive a salary and don’t need to

be paid overtime regardless of how many hours they work.

10. True False The “regular rate” of pay calculation should include bonus payments
that are “non-discretionary.”

Answer Key
1.True

2. False. In addition to being paid on a salary basis, “exempt” employees must satisfy a “test” that covers
compensation, duties and responsibilities.

3. False. lJob titles have no significance in determining exempt status.

4.True.

5. False. If the employee is working while eating, it is still considered to be compensable time.
6. False. The higher minimum wage would take precedence over the lower one.

7. False. According to federal law, overtime is only required on a weekly, not a daily, basis.
8.True.

9. False. Exempt employees usually receive a salary and don’t need to be paid overtime, regardless of how many
hours they work.

10.True.

HR Case Files with Catherine Crier: The FLSA 4 14 p
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EVALUATION FORM

Please circle your rating for each statement.
Your input is IMPORTANT in helping us evaluate and improve our training programs.Thank you for taking time
to think about and respond to the following questions.

Course: Date: Facilitator:
About the Course
1. Were the objectives of the course clearly stated? YES NO

2. How well were the objectives met by the course? Werenotmet 1 2 3 4 5 Were metvery well

3. How applicable will this training be to your job?

Almost none of the material will be applicable to my job.
Some will be applicable, but some was confusing or irrelevant.
Absolutely applicable! | look forward to seeing results soon!

4. Was the information presented in a logical and understandable order?
Didn’t seem logical at all.

Some was, some wasn't.

Yes, all of it seemed logical and understandable.

5. How useful were the discussions and the exercise(s) in helping you learn the information?

Not useful at all Somewhat useful Very useful
6. To what extent did this training meet your expectations?
DID NOT meet my expectations MET expectations EXCEEDED expectations

7. What would you add or change to improve this course?

About the Facilitator

8. Was the facilitator positive and professional? Very much so Could improve

9. How well was the facilitator prepared and able to explain the information?
NOT well prepared 1 2 3 4 5 VERY well prepared

10. Did the facilitator create an atmosphere that encouraged questions and learning?
Yes No - Facilitator should have:

11. Did the facilitator explain the material in ways that made it applicable to your job?
Very much so Sometimes Almost none was connected to my job

Your comments on the facilitator:

www.coastal.com HR Case Files with Catherine Crier: The FLSA 4 15 p
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TRAINING POINTS AND POWERPOINT® OVERVIEW
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OVERVIEW Continued
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OVERVIEW Continued
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CUSTOMIZING A POWERPOINT® PRESENTATION

The PowerPoint® presentations included on the Coastal CD and DVD products are
customizable when used on a computer loaded with Microsoft PowerPoint® software.
(Note: In the following instructions,“click” implies a click with your left mouse button.
If a“right” click is necessary, it will be so indicated.) Microsoft PowerPoint® has many
features. The following steps will help you customize our presentations quickly. To
customize a presentation:

1. If the “Customizable Version” icon is displayed on the landing screen, click on this
option. If this option is not available, click on the PowerPoint® presentation to open it.
Save this presentation to another location, such as your hard drive or a folder on the
network.You will make your customizations on the saved version.

To add, copy, hide or remove a slide, or to change the order of the slides in
the presentation:

2. Click on“View” on the menu bar.

3. Click on “Slide Sorter” from the “View” menu. Or, under the “Normal” view, you may
use the “Outline” on the left side of the screen.

4. To add a slide, place your cursor in front of the slide where you want to add a slide.
Click on“Insert” on the menu bar. Then, click on “New Slide” on the “Insert” menu. Or,
click on the “New Slide” tool on the tool bar. Choose a slide format to fit your desired
content, and follow the prompts given.

5. Sometimes it’s easier to copy a slide, and then change the content of the slide than to
create a new one.To copy a slide, click on the original slide. Click on “Edit” on the
menu bar, and choose “Duplicate.” A new copy will be created to the right of the
original slide. Or, click on “Edit” on your menu bar, and choose “Copy.” You may then
“Paste” the slide wherever you want it to appear.

6. To hide a slide from your presentation, but to keep it for future use, right click on the
slide you wish to hide, and choose “Hide Slide” from the menu. Or, click on the “Hide
Slide” tool on the tool bar.

7. To remove a slide from the presentation, click on the slide you want to remove. Click
on “Edit” on the menu bar.Then, click on “Delete Slide” on the “Edit” menu. Or, click
on the slide, and press the “Delete” key on your keyboard.

8. To change the order of the slides in the presentation, click on the slide to be moved
and while holding the mouse button depressed, drag the slide to its new location.
Release your mouse button to place the slide.
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If you wish to change or remove the animation effect as you move from slide
to slide:
1. Double click on the slide you want to change the animated transition on.

2. Double click on the text box of the slide. A border and white handles appear around
the text box.

3. Click on “Slide Show” on the menu bar.Then, click on “Preset Animation.” To turn
off the effects, choose “Off” If you wish to change the effect, there are many options
to consider.

To edit content of any slide:
1. Double click on the slide you want to change the content of.

2. Double click on the text box of the slide. A border and white handles appear around
the text box.

3. Type the desired changes.

Remember to save any changes made to your presentation!

HR Case Files with Catherine Crier: The FLSA 4 20 »




Copyright © Coastal Training Technologies Corp. 4 21 }

This Leader’s Guide is designed to provide accurate and authoritative information
regarding the subject matter covered. Sources for this information are believed to be
reliable. Because of the possibility of human error, the publisher does not guarantee its
accuracy, adequacy or completeness. Coastal is not responsible for any errors, omissions,
misprinting or ambiguities contained herein or for the results obtained from use of such
information. If legal advice or other expert assistance is required, the services of a
competent professional should be sought.

This Leader’s Guide is one of a series of print materials, video, interactive CD-ROM,
Web-based and DVD programs produced by Coastal Training Technologies Corporation.
Each product is the result of painstaking analysis, design, development and production by
the instructional designers and technical specialists on our staff.

Our catalog is constantly being revised and expanded, so we would appreciate any
comments on current titles or suggestions for future ones. For further information

on any Coastal product, or to receive a free catalog, call Coastal Training Technologies
Corp. (Virginia Beach,VA) at 800-285-9107 or send a FAX to 757-498-3657. Visit us on
the Web at www.coastal.com.

This guide is for educational purposes only. Nothing herein is to be regarded as indicating
approval or disapproval of any specific practice or product.

Copyright © 2004 Coastal Training Technologies Corp. Purchasers and renters may copy
the Pre-Test, Post-Test, Sample Invitation Memo and Evaluation Form found in the Leader’s
Guide when used in conjunction with the program.You may also reproduce the
PowerPoint® slides to use with the program. Any other part of this product may not be
copied by any means or for any reason without the written permission of Coastal Training
Technologies Corporation. All Rights Reserved. Printed in U.S.A.

HR Case Files with Catherine Crier: The FLSA 4 21 p



